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1 NETWORK CONTROL FUNCTION

PC control (i.e., remote control) will be possible when this unit is connected to a network.

Menu settings, recording, playback, and other similar 
operations will be possible from the PC screen.
Up to a maximum of four PCs can be simultaneously 
connected to a single DVR (Digital Video Recorder).
(Example)

Users with user level ID1: 3 PCs
Users with user level ID2 or ID3: 1 PC

Control of the DVR can be freely switched from the unit 
itself to the PC and vice versa. Note that operation of 
the unit will not be affected by simply connecting a 
cable.
In order to provide security for computer control, three 
types of password are set in accordance with the 
different user levels, and this ensures that three 
different levels of restrictions can be introduced for 
operations. ( P. 23)

When this unit is being used while connected to a 
network, network settings must be made on the unit 
itself. See INSTRUCTION MANUAL “Network settings” 
for more details.
TCP/IP settings must be made on the connected PCs 
and in accordance with the operating system (OS) 
being used on each.

When a pre-existing network is being used, a check 
must be carried out by that network’s administrator to 
confirm that IP addresses do not coincide with other IP 
addresses already in use.

The dedicated application DVR Viewer (Ver. 1.5 or 
later) must be installed on the system in order to store 
or playback audio on a networked PC or to playback 
sound-containing video that has been stored on a PC, 
CompactFlash card, or the like. 
Please download this software from our homepage (see 
below).

Sanyo website URL: 
http://www.sanyosecurity.com

1 2 3 4

Camera

DVR (Digital Video Recorder)

Switching hub Switching hub

LAN cable
10BASE-T/100BASE-TX
Category 5 Straight

PC/AT compatible 
machine

Operations possible with PC control Network settings

Saving and playing back sound

e00_l8hbe_xe_nw_7.book  Page 2  Monday, April 26, 2004  10:40 AM



NETWORK CONTROL FUNCTION1

English 3

(1) Double-click the DVR Viewer’s “Setup.exe” icon in 
order to launch the installer. 

After several moments, the “InstallShield Wizard” window 
will be displayed and installation will start. 
When installation has ended, the “Maintenance Complete” 
window will be displayed.
(2) Click [Finish].
This completes the DVR Viewer installation procedure.

After installing DVR Viewer, use the following procedure to 
make Internet security settings.

1 Select “Internet Options...” from the 
Internet Explorer “Tools” menu.

The “Internet Options” window is displayed.

2 Click the “Security” tab.

The “Security” screen is displayed.

3 Click “Custom Level...”.

The “Security Settings” screen is displayed.

Confirm that “Run ActiveX controls and plug-ins” is set to 
“Enable”.
If this is not the case, click “Enable” for “Run ActiveX 
controls and plug-ins”, and then make the following 
settings.

This completes the Internet security setting procedure.

Installing DVR Viewer

Setting Internet Options
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Computer: PC/AT compatible machine
Operating system: Windows 98/98SE/Me/NT4.0/2000/XP
Browser: Internet Explorer Ver. 5.0 or later
Video: 65,000 colors, resolution 800 x 600 dpi or higher

Recommended specifications
CPU: Pentium® III (500 MHz) or better
RAM: 256 MB minimum
OS: Windows 2000, XP, or later

DirectX or compatible sound card
Speaker

The following example applies to Windows XP.
Transmission control protocol/Internet protocol (TCP/IP) is 
the standard protocol used for Internet and Intranet. If this 
unit is to be used when connected to a network, specify a 
TCP/IP to suit each operating system for the computer that 
is used for the settings.

1 Click the [Network and Internet 
Connections] icon in the [Control 
Panel].

The [Network and Internet Connections] window is 
displayed.

2 Click [Network Connections].

The [Network Connections] window is displayed, and
the settings for the LAN card (Ethernet adapter) being 
used will appear in the [LAN or High-Speed Internet] 
column.

3 Right-click on the LAN card (Ethernet 
adapter) being used, and then select 
[Properties] from the pop-up menu.

The [General] tab window in the [Local Area Connection 
Properties] window is displayed.

4 Check that [Internet Protocol (TCP/IP)] 
is selected in the list of components 
used by the Ethernet board that appears 
in the [This connection uses the 
following items:] box.

If [Internet Protocol (TCP/IP)] is not selected, select it.

5 Click [Properties].

The [General] tab window in the [Internet Protocol (TCP/
IP) Properties] window is displayed.

6 Select [Use the following IP address:] 
and then type in the IP address and the 
subnet mask.

7 Check the settings, and then click [OK].

The display will return to the [Local Area Connection 
Properties] window.

8 Click [OK].

This completes the TCP/IP settings.

Ask the network administrator for details on IP address, 
subnet mask, default gateway, and DNS settings.

Minimum system requirements

Audio playback requirements

For Windows XP
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2 PREPARING FOR NETWORK CONTROL

1 Launch the PC’s web browser.

Internet Explorer versions 5.0 and later are supported. 
In terms of OS, Windows 98, 98SE, Me, NT4.0, 2000, and 
XP are supported.

If the Java Script run-time error message is displayed 
while Internet Explorer is being used, modify that 
application’s settings as follows:

(1) Select menus in the sequence [Tools] → [Internet 
Options] → [Advanced].

(2) Uncheck “Display a notification about every script 
error” from the “Advanced” screen, and check “Disable 
script debugging”.

2 Enter the URL.

Enter the unit’s URL in the browser’s address bar and then 
press [Enter]. (Note that the URL should contain the IP 
address specified using the unit’s network settings.) 
To start, enter “http://192.168.0.1/” as the default setting.

If a value other than “80” is set as the default port value, 
enter a colon (:) and then the port number after the IP 
address. 
For example, if the port number was set as “81”, you 
should enter
http://192.168.0.1:81/
If no web browser is installed on the PC, Internet 
Explorer must be installed before proceeding.

3 Enter a password (for verification 
purposes).

Enter a [User name] and a verification-use [Password] on 
the [Connect to 192.168.0.1] screen, and then click [OK]. 
If you entered an incorrect password, the password entry 
screen will appear once again and you will be prompted to 
re-input the password.

Passwords should be setup in advance for the 
hardware environment's different user levels. At the 
time of purchase, the password settings (i.e., user 
name and password) will be as described on P. 23.
If you save the [User name] and [Password] that have 
been entered, verification will be carried out 
automatically on subsequent occasions, and they will 
not need to be entered again. Note, however, that it 
may not be possible to save a password other than that 
used for the default connection.
Up to four PCs can be connected simultaneously to a 
single DVR. Note, however, that users with user level 
ID2 or ID3 are restricted to use of one PC.

When four PCs are connected and access is made from 
a different PC using the highest user level, the most-
recent user of a lower level to have accessed the unit 
will be automatically disconnected and priority will be 
given to the upper-level user.
An error message will appear on the disconnected 
user’s PC. ( P. 7)
When [Cancel] is clicked after repeated input of an 
incorrect password, the authentication error message 
will be displayed.
Even if computer control is being carried out, clicking a 
button for which you do not have authorization will 
result in the password input screen being displayed to 
verify allocation of the required user level.
In the case of certain PC performance levels and 
specifications, a portion of the video may not be 
displayed. If this is the case, go to [Tools]→ [Internet 
Options] → [Temporary Internet Files] → [Settings] in 
Internet Explorer, and then reduce “Amount of disk 
space to use”.

Controlling from a PC
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4 Entering the operation screen

(1) The following screen will be displayed when password 
verification has been completed successfully.

(2) Select the language and click [OK]. The operation 
screen will be displayed and computer control will now 
be possible.

Connection will not be possible when a menu screen is 
being displayed on the DVR unit or when playback-
related operations are being carried out. In such a case, 
cancel the menu screen selection or stop the playback 
operation before attempting to remake connection. 
Connection may not be possible via a proxy server. In 
such a case, cancel the proxy settings.
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Whenever the  button on the PC’s operation screen is 
clicked, access will be cancelled and control rights will 
switch back to the unit.

To forcibly cancel PC access from the unit, press and 
hold the [EXIT] button for at least 2 seconds. 
Access from the PC will not be permitted for a period of 
10 seconds after access has been canceled.
The access connection will also be cancelled whenever 
communication with the PC is not possible for a period 
of about 1 minute or more, and control rights will switch 
back to the unit in such a case.
If the browser is closed without clicking the  button, 
approximately one minute is required before 
reconnection is possible.

Messages related to the switching of control or the network 
connection condition may be displayed on-screen at any 
time.

1 When control rights are switched to the 
PC

“NETWORK CONTROL” appears on the monitor.

The “NETWORK CONTROL” message is not displayed 
when “NETWORK STATUS” has been set to “OFF” 
using the unit’s menu. (Regardless of network 
operations, the unit will continue to display images.)

2 When control rights are switched to the 
unit

Whenever the  button on the PC’s operation screen is 
clicked, access will be cancelled and control rights will 
switch back to the unit. In addition, the “NETWORK 
CONTROL” message from the unit’s on-screen display will 
be changed to “DISCONNECTED”.

Once the message has changed to “DISCONNECTED”, 
it can be cleared by pressing any of the unit’s buttons.

3 Forced disconnection from the unit

To forcibly cancel access by a PC, press and hold the 
unit’s [EXIT] button for at least 2 seconds. When access is 
forcibly cancelled in this way, the “NETWORK CONTROL” 
message will be replaced with “DISCONNECTED”.

Access from the PC will not be permitted for a period of 
10 seconds after access has been canceled.

1 When disconnected from the network

2 When access cannot be made to a 
connected DVR

3 When accessing a DVR that is already 
connected to another 4 PCs

Controlling from the unit

Messages displayed when connected

Display on the unit

02

01-01-04 00:00:00 REC REPEAT EN A ALARM 0000

NETWORK CONTROLNETWORK CONTROLNETWORK CONTROL

Display on the PC

02

01-01-04 00:00:00 REC REPEAT EN A ALARM 0000

DISCONNECTEDDISCONNECTEDDISCONNECTED
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3 OPERATION PANEL FUNCTIONS AND RESTRICTIONS

Operation panel

1. Channel number
Displays the channel number selected using “2. Channel 
selection” below.

2. Channel selection (ID1/2/3)
Used to select a camera channel when displaying video on 
a single screen.

3. [MULTI VIEW] (ID1/2/3)
Used to display video in six split screens. 

4. Previous event (ID2/3)
This button starts playback from the previous alarm event.

5. Next event (ID2/3)
This button starts playback from the next alarm event.

6. Speed down (ID2/3)
This button reduces the playback speed by one setting.

7. Speed up (ID2/3)
This button increases the playback speed by one setting.

8. Reverse playback (ID2/3)
This button starts playback of recorded images in the 
reverse direction.

9. Playback stop (ID2/3)
This button stops playback and calls up the live display.

10. Playback (ID2/3)
This button starts playback of recorded images.

11. Previous image (ID2/3)
This button moves a still image back by one frame.

12. Still (ID2/3)
This button pauses the image during playback.

13. Next image (ID2/3)
This button moves a still image forward by one frame.

14. Search (ID2/3)
This button calls up the search screen (i.e., the setting 
screen).

15. Copy (ID2/3)
This button calls up the copy screen (i.e., the setting 
screen).

16. Download (ID2/3)
This button calls up the download screen (i.e., the setting 
screen).

17. Menu setting (ID3)
This button calls up the menu screen (i.e., the setting 
screen).

18. Disconnect (ID1/2/3)
This button disconnects the PC from the network and 
switches control rights to the unit.

19. Record (ID3)
This button starts normal recording.

20. Record stop (ID3)
This button stops normal recording.

21. Timer (ID3)
This button activates timer standby mode when clicked 
while recording is stopped. If clicked in Timer Standby 
mode, it deactivates this mode.

* Entries in parentheses refer to user level restrictions for 
the specific button. ( P. 23)

Channel and screen selection buttons

Playback buttons

5

7

10

13
12

16

15

17

21

18

19

14

11

8

6

4

20

3

1

9

2

Setting buttons

Recording buttons
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1 SETTINGS

Before using the unit, settings should be made for 
recording conditions, installation environment, and other 
similar factors. The corresponding menu items are 
displayed in a two-level structure comprising main menus 
and sub-menus. 
For more details regarding setting methods, see “2. 
MENU-SPECIFIC SETTINGS” ( P. 11).

1 Click the  button on the operation 
panel.

The MAIN MENU screen is displayed.

2 On the MAIN MENU screen, select and 
click the menu to be used.

The corresponding sub-menu screen appears.

3 Make the required settings.

4 When settings have been completed, 
click the  (Playback stop) button on 
the operation panel.

The normal screen (monitoring image) is displayed.

Menu screens will not be displayed during playback. In 
such a case, stop playback, return to live mode, and 
then click the  button.
You must be connected with user level ID3 to modify 
settings.
It will not be possible to modify settings when the unit is 
recording.
To move from one sub-menu to another, click the  
button to return first of all to the MAIN MENU.

Making menu selection
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 *  indicates the display of information only.

Pull-down menus

When a pull-down menu is clicked, the list of available 
selections will be displayed. 
Select the required value.

Menu structure

Main menu Sub menu Reference 
page

Recording 
conditions

1. CLOCK SET  CLOCK SET 11

2. SUMMER TIME SET/
EXT. CLOCK SET  SUMMER TIME SET   EXT. CLOCK SET 11

3. HOLIDAY SET  HOLIDAY SET 12

4. RECORDING AREA SET  TOTAL CAPACITY   Area-specific capacity  AREA FULL RESET 13

5. RECORDING 
CONDITIONS SET

 NORMAL RECORDING AREA OVERWRITE
 ALARM RECORDING AREA OVERWRITE
 REMAINING DISK WARNING
 AUTO DELETE

14

6. NORMAL REC MODE 
SET

 PICTURE QUALITY   AUDIO RECORDING   REC RATE 
 PROGRAM GROUP 15

7. PROGRAM REC SET  PROGRAM REC SET 16

8. TIMER SET  TIMER SET 17

9. ALARM REC MODE SET

 ALARM RECORDING
 PICTURE QUALITY
 AUDIO RECORDING
 ALARM INTERLEAVE (REC RATE, DURATION)
 PRE-ALARM RECORDING (REC RATE, DURATION)
 ALARM TRIGGER

18

Installation 
environment

10. DISPLAY SET  DATE   TIME   QUALITY   AUDIO   ALARM COUNT
 ALARM TYPE   TITLE 20

11. BUZZER SET  ALARM   DISK FULL   DISK ERROR   LOCK WARNING   KEY IN
 NON REC 21

12. HDD SET  Hard disk capacity  MIRRORING   PLAYBACK DRIVE 22

13. NETWORK SET  IP ADDRESS   SUBNET MASK   GATEWAY   PORT
 PASSWORD SETTING  NETWORK SPEED 22

14. RS-485 SET  DATA SPEED   STATUS INFO
 ALARM INFO  ADDRESS 23

15. MASK SET  MASK (MAIN, MON.2, NETWORK)
 TIME PERIOD   Channel 24

16. POWER FAILURE/
USED TIME  POWER FAILURE   USED TIME   FIRMWARE 24

17. INITIALIZED RECORD  DATE   TIME   AREA 24

Click
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2 MENU-SPECIFIC SETTINGS

Set the unit’s time and date as described below. Be sure 
that the date and time are set correctly at this time.

1 Select the “Day/Month/Year/Hour/ 
Minutes” field from the pull-down menu 
on the screen.

The day of the week will be set automatically based on the 
date.

2 Click [SET]. 

The current time is set.

Recording mode may not be activated if a time has not 
been set. In such a case, the following warning will be 
displayed when you click the  button or the  
button.
“PLEASE SET THE CLOCK”

1 Change the setting for summer time 
from the pull-down menu on the screen.

[Settings] (  indicates default setting.)

2 Set the date/time at which to switch 
from standard time to summer time 
from the pull-down menu on the screen.

3 Set the date/time at which to switch 
from summer time to standard time 
from the pull-down menu on the screen.

Synchronized operation will not be possible when time 
differences exist between the unlt and the connected 
peripheral devices. By setting the external time as 
described here, all devices connected to the clock adjust 
terminal can be set to the same time.

4 Select “ADJUST TIME” from the pull-
down menu on the screen.

Each day at the specified time, a signal will be output to 
adjust the time of connected devices.
(Default setting: 01:00)

5 Click [SAVE]. 

The summer time or adjustment time is set.

1. CLOCK SET

1

2

2. SUMMER TIME SET/EXT. CLOCK 
SET

SUMMER TIME SET setting

Setting Description

USE Time is automatically adjusted to summer time.

NO USE Time is not automatically adjusted to summer 
time.

EXT. CLOCK SET setting

4
5

1

2
3
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Set specific days as holidays using the procedure 
described below. 
When a day is specified as a holiday, timer recording for 
that day will be carried out as if it were a Sunday. 
Dates such as national holidays and company off days 
should be set as holidays when you want those dates to 
have the same security as Sundays.

1 Specify the day to be treated as a 
holiday from the pull-down menu on the 
screen.

Left side: Day Right side: Month
A maximum of 20 different days can be specified as 
holidays.

2 Click [SAVE]. 

The saved or modified settings are stored.

3. HOLIDAY SET

1

2
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The unit’s hard disk is separated into three independent recording areas. Furthermore, five different recording modes can be 
used for these three areas. 
The memory capacity for each area is allocated as a percentage. (Setting units: 1%)

1 Total capacity display

This section displays the total capacity of the hard disk.

If two hard disks are installed and mirroring is set to 
“ON” using the digital video recorder’s hard disk 
settings, the smaller disk capacity will be shown.

2 Area-specific capacity display

This section displays the capacity set by the unit for each 
recording area as a percentage of the total capacity.

Setting and modification of recording area capacities 
cannot be carried out from a PC.

3 Recording area reset

When the overwrite setting is “OFF”, recording will be 
automatically stopped when the corresponding recording 
area has been filled with image data. In such a case, 
[AREA FULL RESET] can be clicked to overwrite from the 
beginning of each area.

The ability to perform a reset will not be required in the 
following cases, and for this reason, [AREA FULL RESET] 
is not displayed.

When the capacity setting for both the normal recording 
area and the alarm recording area is 0%.
When the overwrite setting is “ON”.

4. RECORDING AREA SET

Recording area Recording mode Recording method

Normal 
recording area

Normal 
recording Manual Recording is performed in response to manual operation of the operation panel’s  

button.

Timer recording Automatic Recording is performed automatically over the time range set using “8. TIMER SET” from 
the MAIN MENU.

Alarm recording 
area

Alarm recording Automatic Recording is performed automatically upon occurrence of an alarm set using “9. ALARM 
REC MODE SET” from the MAIN MENU.

Pre-alarm 
recording Automatic

Automatic recording of images before an alarm is performed automatically in 
accordance with “PRE-ALARM RECORDING” from the MAIN MENU’s “9. ALARM REC 
MODE SET”. This is used as a complementary function for alarm recording.

Archive area Copy Manual The required images are copied from another recording area and stored in response to 
manual operation of the operation panel’s  button.

(2)

(3)

(1)

e00_l8hbe_xe_nw_7.book  Page 13  Monday, April 26, 2004  10:40 AM



MENU-SPECIFIC SETTINGS2

14 English

N
ETW

O
R

K
 

SETTIN
G

S

Set the permission for overwriting to recording areas or the 
remaining-space warning level as described below.

When the normal recording area has been filled with data, 
this setting dictates whether recording will be stopped or 
continued by overwriting the recorded images currently 
stored on the hard disk.

1 Select “OVERWRITE” for normal 
recording area from the pull-down menu 
on the screen.

[Settings] (  indicates default setting.)

When the alarm recording area has been filled with data, 
this setting dictates whether recording will be stopped or 
continued by overwriting the recorded images currently 
stored on the hard disk.

2 Select “OVERWRITE” for alarm 
recording area from the pull-down menu 
on the screen.

[Settings] (  indicates default setting.)

In situations where the overwrite setting for the normal 
recording area and the alarm recording area is “OFF”, you 
can have the unit issue a warning as soon as the 
remaining space in either of these areas reaches a specific 
level. ( P. 21)
The following section describes how to set the level at 
which the warning will be issued.
(This level is common for the normal recording area and 
the alarm recording area.)

3 Set the remaining-space warning level 
from the pull-down menu on the screen.

Setting range: 1% to 10% (in units of 1%)

You can set the storage period for images. When the set 
period has expired, the corresponding data will be 
automatically deleted.

4 Set “AUTO DELETE” from the pull-down 
menu on the screen.

[Settings] (  indicates default setting.)

If the overwrite setting for the normal recording area 
and the alarm recording area is “ON”, the remaining-
space warning level will be displayed as “**” and setting 
will not be possible.

5 Click [SAVE]. 

The new setting is saved.

5. RECORDING CONDITIONS SET

Setting overwriting permission for the normal 
recording area

Setting Description

ON
When the normal recording area has been filled with 
data, overwriting from the beginning of this area will 
start automatically.

OFF Recording is stopped when the normal recording area 
has been filled with data.

Setting overwriting permission for the alarm 
recording area

Setting Description

ON
When the alarm recording area has been filled with 
data, overwriting from the beginning of this area will 
start automatically.

OFF Recording is stopped when the alarm recording area 
has been filled with data.

1

2

3

4

5

Setting the remaining-space warning level

Setting the auto delete

Setting Description

OFF Auto delete is not to be set

1 -99 
DAYS

You can set the storage period for recorded data 
within a range of  “1 DAY” - “99 DAYS” (full days).
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Set conditions for normal recording and timer recording as 
described below.

Set the picture quality for recording to the normal recording 
area as follows.

1 Select “PICTURE QUALITY” from the 
pull-down menu on the screen.

[Settings] (  indicates default setting.)

Audio can be recorded together with images when 
performing normal recording.
Note, however, that since this audio data will also be 
stored in the normal recording area, the recording time for 
this area will be reduced.

2 Select “AUDIO RECORDING” from the 
pull-down menu on the screen.

[Settings] (  indicates default setting.)

Audio recording can only be specified when the 
recording rate is A60 to A1 FPS.

Set the recording rate for normal recording as follows.
(Default setting: A15 FPS)

3 Select “REC RATE” for normal 
recording from the pull-down menu on 
the screen.

The letter “A” will be displayed in front of recording rates 
that can be set for audio recording.

Selecting setting values
Image resolution is determined by the product of picture 
quality and recording rate. The higher the picture quality 
and the faster the recording rate, the better the image 
resolution; however, as higher resolution requires more 
storage capacity, the recording time will be reduced 
accordingly.

The recording rate will be limited between A30 and 
0.033 FPS when the setting for pre-alarm recording is 
“ON”.
The recording rate for timer recording should be set 
separately using the TIMER SET menu. ( P. 17)

4 Select “REC PROGRAM GROUP” from 
the pull-down menu on the screen.

Select OFF, P-1, P-2, P-3, or P-4.

Settings for program groups should be made separately 
as described in “7. PROGRAM REC SET”. ( P. 16)

5 Click [SAVE]. 

The new setting is saved.

6. NORMAL REC MODE SET

Setting the picture quality for recording

Setting Description

SUPER FINE Super Fine

FINE Fine

ENHANCED Enhanced

NORMAL Normal

BASIC Basic

Setting audio recording

Setting Description

ON Audio will be recorded.

OFF Audio will not be recorded.

1

2

3

4

5

Setting the recording rate

Audio recording 
is carried out

A60, A30, A20, A15, A10, A7.5, A6, A5, 
A4.286, A3.75, A3.333, A3, A2.727, A2.308, 
A2, A1.667, A1.429, A1.25, A1.111, A1

Audio recording 
is not carried out 0.5, 0.333, 0.25, 0.2, 0.1, 0.05, 0.033
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When monitoring a number of cameras connected to this 
digital video recorder, a separate recording rate can be set 
for each camera. In addition, video recorded from each 
camera and the corresponding recording rates can be set 
in programs with up to four patterns, thus facilitating the 
simple specification of programs for timer-setting and 
normal recording setting menus.

Set the picture quality for recording to the normal recording 
area as follows.

1 Select “PROGRAM” from the pull-down 
menu on the screen.

Select from P-1 through P-4.

2 Select “SELECT INDIVIDUAL CAMERA 
RATE (FPS)” from the pull-down menu 
on the screen.

Of the displayed cameras, select those from which video is 
to be recorded, and then set a recording rate for each.

[Settings] (  indicates default setting)

Usable recording rates
30, 15, 7.5, 3.75, 1.875, 1, 0.5, 0.33, 0.25, 0.2, 0.1, 
0.05, 0.03
(Unit: FPS)

The recording rates listed in pull-down menus vary 
according to the connected channels.

3 Click [SAVE].

When setting has been completed, the associated normal 
recording time quantity is displayed for reference 
purposes.

4 Use the above procedure to set up to 
four program patterns.

Set values are lost if switched to a different window 
without clicking [SAVE].

7. PROGRAM REC SET

Setting Description

OFF Video will not be recorded from the selected 
camera.

REC RATE Sets the rate for recording.

1
2

3
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Set timer operation duration and timer recording conditions on a day-specific basis as shown below.

1 Setting timer recording conditions for 
different days of the week.

(1) WEEK
These fields specify the days of the week for timer 
recording. By using multiple setting rows, it is possible to 
setup timer recording a number of different times on a 
single day.
(2) START
These fields are used to enter the time at which to start 
timer recording.
(3) STOP
These fields are used to enter the time at which to stop 
timer recording.

(4) PROGRAM
To carry out program recording, select a program (P-1 
through P-4). ( P. 16)
(5) REC RATE
These fields set the recording rate. ( P. 15)
To carry out program recording, set to “***”.
(6) SET
Set these fields to “ON” to set timer recording.
Set these fields to “OFF” when timer recording is not to be set.
(7) SAT, DLY
When the start and stop times, program, and the recording 
rate have been entered and “ON” has been selected for 
“SET”, you will be able to carry out timer recording over the 
same period every day. 
(8) EXT
Displays details set by an external timer. (These are not 
start and end time settings.)

If “DLY” is set for any other day, all rows will adopt this 
setting.

2 Click [SAVE].

Timer setting (or modification) is completed.

Performing timer recording
Click the  button on the operation panel. ( P. 8)

Overlapping of timer reservation times
If timer settings overlap, recording is performed in 
accordance the following priority sequence.
Individual reservations → “DLY” → “EXT”
(High) ←−−−−−−−−−− Priority −−−−−−−−−→ (Low)
If a reservation for a particular day overlaps with a daily 
reservation, priority is given to that with the earliest start 
time. If both have the same start time, priority is given to 
that with the highest setting position in the menu.

Setting a timer for over 24-hours continuous 
recording
The bottom two lines of the TIMER SET screen are 
used to make settings for this type of recording.
(1) Click [OVER 24H] to switch the setting format.
(2) Set the day and time for the start of recording in the 

upper row.
(3) Set the day, time, program and recording rate for 

the end of recording in the lower row.
(4) Select “ON” for “SET” on the bottom row to specify 

timer recording extending for over 24 hours.

8. TIMER SET

(1) (3) (4) (6)

(7)
For setting timer 
recording spanning 
more than 24 hours

(2) (5)

2

(8)
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Set the recording conditions for alarm recording as follows.

In order to carry out alarm recording, it will be necessary to 
set operation patterns and recording conditions.

1 Select a mode using “ALARM 
RECORDING” from the pull-down menu 
on the screen.

[Settings] (  indicates default setting.)

Set the picture quality for alarm recording as follows.

2 Select “PICTURE QUALITY” from the 
pull-down menu on the screen.

[Settings] (  indicates default setting.)

Audio can be recorded together with images when 
performing alarm recording. Note, however, that since this 
audio data will also be stored in the alarm recording area, 
the recording time for this area will be reduced.

3 Select “AUDIO RECORDING” from the 
pull-down menu on the screen.

[Settings] (  indicates default setting.)

Audio recording can only be specified when the 
recording rate is between A30 and A1 FPS.

4 Select “ALARM INTERLEAVE” from the 
pull-down menu on the screen.

[Settings] (  indicates default setting.)

9. ALARM REC MODE SET

Setting alarm recording

Setting Description

OFF Does not perform alarm recording.

ENABLED Alarm recording is always performed, 
regardless of timer recording or timer settings.

AL-REC ON 
TIMER

Alarm recording is performed only during timer 
recording.

AL-REC OFF 
TIMER

Alarm recording is performed only during 
recording other than timer recording.

OLY AL-RC 
ON TMR

Alarm recording is performed only in the 
period set for timer recording without timer 
recording actually being performed.

1

Setting the picture quality for recording

Setting Description

SUPER FINE Super Fine

FINE Fine

ENHANCED Enhanced

NORMAL Normal

BASIC Basic

Setting audio recording

Setting Description

ON Audio will be recorded.

OFF Audio will not be recorded.

2
3

5

4
6

Setting the alarm interleave
Setting Description

SW
Recording is switched between camera video 
including an alarm and video from all connected 
cameras.
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5 Select “REC RATE” from the pull-down 
menu on the screen.

(Default setting: A15 FPS)

The letter “A” will be displayed in front of recording rates 
that can be set for audio recording.

6 Set the duration for alarm recording 
using “DURATION” from the pull-down 
menu on the screen.

5 SEC, 10 SEC, 20 SEC, 40 SEC, 1 MIN, 2 MIN, 3 MIN, 
4 MIN, 5 MIN, 10 MIN, 15 MIN, CC*1

 (Default setting: 20 SEC)
*1 Operates while an alarm is being activated.

Set the recording conditions to be used for pre-alarm 
recording as described below. ( P. 25)

7 Select “ON” or “OFF” using “PRE-
ALARM RECORDING” from the pull-
down menu on the screen.

[Settings]

When “OFF” has been selected for “ALARM 
RECORDING”, this item will be displayed as “**” and 
selection will not be possible.

8 Make a selection for “REC RATE” from 
the pull-down menu on the screen.

(Default setting: A15 FPS)

The letter “A” will be displayed in front of recording rates 
that can be set for audio recording.

9 Set the duration for pre-alarm recording 
using “DURATION” from the pull-down 
menu on the screen.

3 SEC, 5 SEC, 10 SEC, 20 SEC, 40 SEC, 1 MIN, 2 MIN, 
3 MIN, 4 MIN, 5 MIN, 10 MIN, 15 MIN
(Default setting: 1 MIN)

ONLY Video is recorded only from cameras with an 
alarm occurring.

Audio recording 
is performed

A30, A20, A15, A10, A7.5, A6, A5, A4.286, 
A3.75, A3.333, A3, A2.727, A2.308, A2, 
A1.667, A1.429, A1.25, A1.111, A1

Audio recording 
is not performed 0.5, 0.333, 0.25, 0.2, 0.1, 0.05, 0.033

Setting pre-alarm recording

Setting Description

ON Performs pre-alarm recording.

OFF Does not perform pre-alarm recording.

Audio recording 
is performed

A30, A20, A15, A10, A7.5, A6, A5, A4.286, 
A3.75, A3.333, A3, A2.727, A2.308, A2, 
A1.667, A1.429, A1.25, A1.111, A1

7
8 9
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Set the alarm triggers (i.e., launch signals) that constitute 
operation conditions for alarm recording as follows.

10 Select a launch signal for alarm 
recording using “ALARM TRIGGER” 
from the pull-down menu on the screen.

[Settings] (  indicates default setting.)

External alarm detection
The term “external alarm detection” is used to describe 
input of an external detection signal from a door switch 
or the like to the unit's alarm input terminal.
Motion sensor detection
The term “motion sensor detection” is used to refer to 
detection of motion on the monitor in accordance with 
motion sensor settings.
The setting of motion sensors is carried out using the 
digital video recorder.

11 Click [SAVE].

The new settings is saved.

Set conditions for the display of data on the unit’s monitor 
by selecting “ON” or “OFF” for each item.

These settings apply to information displayed on the 
monitor connected to the unit, not to the PC monitor’s 
display information.

1 Select “ON” or “OFF” for each data 
display item.

2 Click [SAVE]. 

The on-screen data display conditions are set or modified.

Setting alarm triggers

Setting Description

ALARM Starts recording when an external alarm is 
activated.

SENSOR Starts recording when a motion sensor is 
activated.

ALARM AND
SENSOR

Starts recording when both an external alarm 
and a motion sensor are activated 
simultaneously.

ALARM OR 
SENSOR

Starts recording when an external alarm or a 
motion sensor is activated independent of the 
other.

10

11

10. DISPLAY SET

Item Default 
setting Description

(1) DATE ON Sets whether the current date or 
recording date will be displayed.

(2) TIME ON Sets whether the current time or 
recording time will be displayed.

(3) QUALITY ON Sets the picture quality for recording 
or playback.

(4) AUDIO ON Sets the display condition for audio 
recording.

(5) ALARM 
COUNT ON Displays the number of recorded 

alarms.

(6) ALARM 
TYPE ON

Sets the alarm recording type.
For alarm recording:
“ALARM” is displayed
For pre-alarm recording.
“PRE” is displayed 

(7) TITLE ON Sets the display condition for camera 
title.

(1)

2

(3)

(7)

(5)

(2)

(4)

(6)
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Set a warning buzzer to sound for alarms or when the hard 
disk space reaches zero as described below.

1 Select “ON” or “OFF” for the alarm 
buzzer.

2 Click [SAVE]. 

The new settings are saved.

These settings apply to the digital video recorder’s 
buzzer. To sound a buzzer on the PC, refer to NOTE.

To sound a buzzer on the PC
Create a folder named “BUZZER” within the root 
directory of the PC's C drive.
Within this folder, save the sound to be used as a 
buzzer in .wav format and with the name 
“BUZZER.WAV”.
Example: C:\BUZZER\BUZZER.WAV

Once these settings have been made, whenever a key is 
pressed on the digital video recorder or an error occurs, 
the PC will provide notification by playing the saved .wav 
file.
* Only the first second of the saved audio file will be 

played, and for this reason, it is advisable to choose a file 
with suitable audio in the first second. Furthermore, the 
use of large audio files is discouraged.

* The buzzer will only sound in response to alarm input.

To cancel sounding of a buzzer on the PC
Delete the folder or file created in the above-mentioned 
process, change the name of the audio file, or move it 
to a different location on the hard disk.
Press the  (Playback stop) button to stop the 
buzzer of PC.

Different settings cannot be used for the recorder and 
the PC.
When the PC buzzer is sounded, it can be stopped by 
pressing any button on the digital video recorder.

11. BUZZER SET

Item Default 
setting Description

(1) ALARM OFF Sounds a buzzer when an alarm is 
detected.

(2) DISK 
FULL ON

Sounds a buzzer when the amount of 
data stored in each of the hard disk’s 
recording areas has reached the 
remaining-space warning level. 
( P. 14)

(3) DISK 
ERROR ON Sounds a buzzer when a hard-disk 

error occurs.

(4)
LOCK 
WARN-
ING

ON

Sounds a buzzer when an operation 
button not permitted for the current 
user level is pressed while the secu-
rity lock is set. Specifically, the 
buzzer sounds twice with an interval 
of approximately 0.5 seconds.

(5) KEY IN OFF The buzzer emits a key-operation 
sound each time a button is pressed.

(6) NON REC OFF Sounds a buzzer when recording is 
stopped.

(1)
(2)

2

(3)
(4)
(5)
(6)
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This screen provides information regarding the hard disk.

(1) Hard disk capacity
This item displays the total capacity of the hard disk.
If hard disk expansion is carried out, a value will be 
displayed for each disk.

(2) MIRRORING
This item displays settings relevant to mirroring-type 
recording on the digital video recorder.

[Settings] (  indicates default setting.)

Mirroring
When hard disk expansion has been carried out, the 
same video can be recorded to both hard disks in a 
process known as “mirroring”. Even if a problem occurs 
in the writing of video data to one of the disks, it will be 
possible to extract normal data from the other disk 
when this function is turned on.

(3) PLAYBACK DRIVE
This item indicates which of the hard drives will be 
used to provide video for playback when mirroring has 
been turned on.

[Settings] (  indicates default setting.) 

The “***” will be displayed for “PLAYBACK DRIVE” 
when only one hard disk is being used or when 
“MIRRORING” is set to “OFF”. Settings can not be 
made in these cases.
When this setting is made after hard disk expansion, 
the hard disks will be initialized and all recorded video 
will be lost. If any important recordings are stored on the 
hard disks, they should be stored on a separate data 
storage device before making this setting.

Network settings must be made in advance on the unit 
whenever it is to be controlled via a network. Once this has 
been done, settings can then be changed from the 
controlling PC.

Changing network-related settings
When these settings are modified, connection will be 
canceled and control rights will be returned to the unit. 
To restore the connection, repeat network settings on 
the PC to match the modified unit settings.

1 Change the settings as required.

12. HDD SET

Setting Description

ON Mirroring recording is carried out.

OFF Mirroring recording is not carried out.

Setting Description

*** Mirroring is not carried out.

DISK1 Playback data is read from disk1.

DISK2 Playback data is read from disk2.

(1)
(2)
(3)

13. NETWORK SET

Item Description

(1) IP ADDRESS Allows the unit’s IP address to be 
modified.

(2) SUBNET MASK Allows the unit’s subnet mask to be 
modified.

(3) GATEWAY Allows the unit’s gateway to be modified.

(4) PORT
Allows the unit’s port number to be 
modified. Set within the range of 1 to 
65535. (default setting: 80)

(1)

(2)
(3)

(4)

(5)

(6)

2
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If a value other than “80” is set as the default value for 
the port, when specifying the URL, enter a colon (:) and 
then the port number after the IP address. 
For example, if the port number was set as “81”, you 
should enter
http://192.168.0.1:81/

If settings are changed during network control, the 
connection will be terminated.

(5) PASSWORD SETTING
This item allows you to set a password for each different 
user level.

Use between 4 and 8 alphanumeric characters for 
passwords.

(6) NETWORK SPEED
This item lets you modify the network speed setting. 
(Network speed cannot be set using the digital video 
recorder.)
NO LIMIT, 64, 128, 256, 512, or 1024 (kbps)
When the unit is reset, the network speed setting will revert 
to the default value (i.e., NO LIMIT).

2 Click [SAVE]. 

The network settings or modifications are saved.

This screen displays settings relevant to the unit’s 
interfaces.

It will not be possible to modify settings: The screen 
displays data for confirmation purposes only.

User level 1 2 3

User name ID1 ID2 ID3

Usable 
menus

Monitoring of live images

Monitoring and searching 
of recorded images

Starting and stopping of 
recording; timer recording; 
modification of unit 
settings, etc.

Password (default setting) 1111 2222 3333

14. RS-485 SET

Item Overview Setting Description

(1) DATA 
SPEED

Displays the RS-485 
communication speed.

2400/
4800/
9600/
19200 
(bps)

(2) STATUS 
INFO

Displays whether or 
not status information 
will be transmitted 
during RS-485 
communication.

ON

Status 
information 
will be 
transmitted.

OFF

Status 
information 
will not be 
transmitted.

(3) ALARM 
INFO

Displays whether or 
not alarm information 
will be transmitted 
during RS-485 
communication.

ON

Alarm 
information 
will be 
transmitted.

OFF

Alarm 
information 
will not be 
transmitted.

(4) ADDRESS
Displays the address 
when RS-485 has 
been selected.

0 to 
127

Set within 
the range of 
0 to 127.
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Use the following procedure to set video from individual 
cameras to be masked by a gray pattern when it is not 
needed on a monitor screen.

1 Set the following functions as required.

2 Click [SAVE].

The setting is saved.

Network mask settings are valid only for the user 
connecting to the network with ID1. Users connecting 
using ID2 and ID3 will be able to display all channels.

Check the date and time of power failures and the amount 
of hard disk usage as described below.

Check the records for hard-disk initialization and area 
resetting.

15. MASK SET

Setting Description

(1) MASK Turns masking on or off.

(2) TIME 
PERIOD

Selects one of the time periods, T-1 through 
T-4.

(3) CH
Turns each channel's masking on or off 
individually for the main monitor, the monitor 
2, and network video.

(1)

(2)

2

(3)

16. POWER FAILURE/USED TIME

Item Description

(1) POWER 
FAILURE

Displays the number of power failures and the 
date and time of occurrence and restoration 
for the four most recent power failures.

(2) USED TIME

Displays the usage time for the digital video 
recorder.
DISK1 USE: Total usage time for Disk 1
DISK2 USE: Total usage time for Disk 2
POWER: Total usage time for the unit

(3) FIRMWARE Displays the firmware version.

17. INITIALIZED RECORD

Item Description

(1) DATE Displays the date of the operation.

(2) TIME Displays the time of the operation.

(3) AREA Displays the area in question and the 
corresponding operation content.

(1)

(2)

(3)

(1) (2) (3)
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1 RECORDING IMAGES

This section will describe the way in which monitored 
images and alarm images can be stored on the unit’s 
internal hard disk. 
Before any of these operations can be carried out, it will be 
necessary to make menu settings to match the installation 
environment. ( P. 10)

Monitored images can be recorded to the normal recording 
area by a manual operation.

1 Click the  button on the operation 
panel.

Normal recording starts.

2 Click the  button on the operation 
panel.

Monitored images can be automatically recorded to the 
normal recording area in accordance with timer settings. 
Note that timer recording will not operate during normal 
recording.

1 Set the conditions for timer recording 
using the timer setting menu screen. 
( P. 17)

2 Click the  button on the operation 
panel.

The unit will enter standby mode for timer recording, and 
recording will then start and stop automatically at the set 
times. The current condition for timer recording is 
displayed on-screen using the message “TIMER 
STANDBY” or “TIMER RECORDING”.

If “OLY AL-RC ON TMR” has been selected using the 
“ALARM REC MODE SET” menu item ( P. 18), it will 
not be necessary to click the  button to setup 
standby mode.

3 With “TIMER STANDBY” displayed, 
click the  button on the operation 
panel.

When an alarm is detected by the alarm input terminal or a 
motion sensor, the recording of alarm images to the alarm 
recording area will start automatically.
Whenever alarm recording starts, normal recording, timer 
recording, and pre-alarm recording will be automatically 
terminated, and they will be automatically restarted as 
alarm recording ends.

1 Set the conditions for “ALARM 
RECORDING” using the “ALARM REC 
MODE SET” menu screen. ( P. 18)

(1) Regardless of the unit’s current operation or condition, 
alarm recording will be started automatically whenever 
an alarm is detected.

(2) When the duration set for alarm recording has ended, 
alarm recording will be automatically stopped.

Settings can be made to have a buzzer sound on the 
PC when an alarm occurs on the digital video recorder. 
( P. 21)

When the alarm sound stops during alarm recording, click 
the stop button on the operation panel.

Pre-alarm recording can be set to record video just before 
an alarm. It will be possible to view images from just before 
an alarm when alarm recording is being played back.

1 Set the conditions for “PRE-ALARM 
RECORDING” using the “ALARM REC 
MODE SET” menu screen. ( P. 19)

(1) The newest images from the preset duration will be 
automatically recorded and updated by overwriting.

(2) Pre-alarm recording will be automatically terminated 
whenever alarm recording starts, and it will be 
automatically restarted as alarm recording ends.

Normal recording

Stopping normal recording

Timer recording

Canceling timer recording

Alarm recording

Pre-alarm recording
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N(1) READ INTERVAL (Default setting: 1)
This item allows you to select one of five image display 
speeds. 
Larger setting numbers correspond to higher speeds; 
however, the actual speed will depend on the speed of 
your network connection.
* When “(4) AUDIO” is set to “ON”, “READ INTERVAL” 

cannot be set.

(2) SIZE (Default setting: 1)
This item allows you to select one of six image sizes. 
Larger setting numbers correspond to larger image sizes.

* Size for full screen monitoring.

(3) QUALITY (Default setting: 2)
This item allows you to select one of three picture quality 
settings for PC display. (Only live mode)

(4) AUDIO (Default setting: OFF)
Sound can be played in live mode or play mode.
* Set only for full screen monitoring.

[Settings]

(5) SAVE TO PC (Default setting: OFF)
When this is set to “ON”, live images or playback images 
can be saved on a PC.
* Size for full screen monitoring.

A user level of ID2 or better is required for the playing 
back and saving to PC.
When audio is to be played back, store the audio on the 
PC, install “DVR Viewer” for playback ( P. 2), and then 
set audio recording to “ON”. 
Playback will be performed with priority given to audio, 
and as a result, images may not be displayed for certain 
hardware and software configurations.
Audio playback is not possible for multi-screen display.

(6) Image mode
LIVE: Live mode
PLAY: Play mode

(7) Time
Live mode: Displays the current time
Play mode: Displays the recording time

Screen display items

1 320 × 240 4 800 × 600

2 400 × 300 5 1,024 × 768

3 640 × 480 6 1,280 × 960

1 Lowest quality

2 Standard quality

3 Best quality

(7)

(1)

(9)

(4)(3)(2)(5)

(6) (10)(8)

Setting Description

OFF Audio will not be played.

ON-5SEC
ON-10SEC
ON-15SEC
ON-20SEC
ON-30SEC

Screen indicating the 
reading of audio data

Audio will be played.
Set the audio delay (5, 10, 15, 20, or 30 
seconds). 
In Play mode, the speed of fast-forward 
and frame advance may be affected by 
the network environment being used. 
In addition, if the audio-data reading 
screen appears frequently, the audio 
delay (5, 10, 15, 20, or 30 seconds) 
should be made longer to match the 
network environment. 
If this screen continues to appear frequently 
even when the delay time is 30 seconds, it 
indicates that audio playback is not possible 
with the network environment being used.

* Audio delay
The delay time prevents sound dropouts 
and the loss of synchrony between video 
and sound.
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(8) NORMAL RECORDING MODE
This item displays the current condition for normal 
recording.

STOP
RECORDING
TIMER STANDBY
TIMER RECORDING
AREA FULL (in normal recording area)

(9) ALARM RECORDING MODE
This item displays the current condition for alarm 
recording.

STOP
PRE ALARM RECORDING
ALARM RECORDING
AREA FULL (in alarm recording area)

(10)Connection user
In situations where a number of different users are 
connected, this item displays the connection condition for 
the various user levels.
Typical display: ID1: 3  ID2: 1  ID3: 0
The user ID for the current user is displayed in red.
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2 WATCHING IMAGES

Monitored live images and recorded images can be viewed 
freely and whenever so required.
Note that switching to live or playback images, modifying 
the screen display, and other similar operations have 
absolutely no effect on timer recording and alarm 
recording.

Click the  (Playback stop) button on the operation 
panel. When playback has finished, the screen will switch 
back to the display of monitored live images.

The following two methods are available for the playback 
of images.

Interference may appear on images or the playback may 
seem to have paused during the following operations; 
however, this is normal and no cause for concern.

When the images from the normal recording area and 
the alarm recording area are played back in succession, 
the quality of the picture may drop momentarily as 
playback switches from one recording area to another. 
If normal, fast-forward, or fast-rewind playback is 
carried out either for playback during alarm recording or 
continuous playback from the normal recording area 
and alarm recording area, the image may seem to have 
paused in certain cases.

Watching live images during playback

Playing back recorded images

Image 
specification Replay method

When no 
images are 
specified for 
replay

Click the  button on the operation panel to 
switch to play mode and commence the 
playback of images from the normal recording 
area and the alarm recording area in the 
sequence in which they were recorded.

When recorded images are played back for 
the first time or when a reset is performed 
from the unit, playback will start from the 
beginning of the stored data.
Any subsequent playback will start at the last 
stop point.

When images 
are specified 
for replay

The search function can be used to find the 
required images from the data stored in the 
hard disk’s various recording areas.
When the image for playback has been 
identified using search mode, the play mode 
screen will be automatically called up and the 
specified image will be played. For more 
details, see “3. SEARCH MODE” ( P. 33).

Buttons used for 
playback
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When a number of cameras are connected to the digital 
video recorder, it is possible to monitor video from several 
of these in multi-screen format. Use the following 
procedures to specify the channel numbers for the 
cameras to be displayed and the number of screens.

Click a [CHANNEL].
Click the button for the camera to be monitored. The video 
from the specified channel will be displayed on the full 
screen, and the corresponding number will be displayed in 
the “CHANNEL” box.

Press the [MULTI VIEW] button.
Video from all recording and recorded cameras will be 
displayed on a screen divided into six individual portions.

To resume full screen monitoring
Either click a [CHANNEL] button or double click one of the 
multiple screens being displayed to resume single-screen 
monitoring.

Video from each screen of the multi-screen will be 
updated at a speed appropriate for its channel. In 
addition, network conditions will also affect the updating 
speed.

Click the  button.

During playback, click the  or  
button.

: Increases the playback speed.
: Reduces the playback speed.

Click the  button.

During reverse playback, click the  or 
 button.

: Increases the reverse playback speed.
: Reduces the reverse playback speed.

During playback, click the  button.
Playback will be paused on the current image. 
To return to normal play mode, click the  button while 
playback is paused.

While playback is paused, click the  or 
 button. 

: Advances a frame in the forward direction.
: Advances a frame in the reverse direction.

During playback, click the  or  
button. 
The previous or next alarm image is displayed accordingly.

: Skips to the next alarm video.
: Skips to the previous alarm video.

During playback, click the  (Playback stop) button.

Specifying the number of screens to 
display

Viewing on a full screen

Viewing on a multi 6 screen

[CHANNEL]

[MULTI VIEW]

Performing operations in play mode

Playback

Adjusting the playback speed

Reverse playback

Adjusting the reverse playback speed

Still image

Frame advance (forward/reverse)

Alarm skip

Stopping playback
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The images displayed on screen can be adjusted in a 
number of ways. 
To make an adjustment, select the adjustment value from 
the menu and then click [SET] from the pull-down menu on 
the screen.

(1) READ INTERVAL (Default setting: 1)
This item allows you to select one of five image display 
speeds. 
Larger setting numbers correspond to higher speeds; 
however, the actual speed will depend on the speed of 
your network connection.
* When “(4) AUDIO” is set to “ON”, “READ INTERVAL” 

cannot be set.

(2) SIZE (Default setting: 1)
This item allows you to select one of six image sizes. 
Larger setting numbers correspond to larger image sizes.

* Size for full screen monitoring.

(3) QUALITY (Default setting: 2)
This item allows you to select one of three picture quality 
settings for PC display. (Only live mode)

(4) AUDIO (Default setting: OFF)
Sound can be played in live mode or play mode.
* Set only for full screen monitoring.
[Settings]

(5) SAVE TO PC (Default setting: OFF)
When this is set to “ON”, live images or playback images 
can be saved on a PC.
* Set only for full screen monitoring.

A user level of ID2 or better is required for the playing 
back and saving to PC.
When audio is to be played back, store the audio on the 
PC, install “DVR Viewer” for playback ( P. 2), and then 
set audio recording to “ON”. 
Playback will be performed with priority given to audio, 
and as a result, images may not be displayed for certain 
hardware and software configurations.
Audio playback is not possible for multi-screen displays.
In the case of certain PC performance levels and 
specifications, a portion of the video may not be 
displayed. If this is the case, go to [Tools] → [Internet 
Options] → [Temporary Internet Files] → [Settings] in 
Internet Explorer, and then reduce “Amount of disk 
space to use”.

Adjusting the image and audio

1 320 × 240 4 800 × 600

2 400 × 300 5 1,024 × 768

3 640 × 480 6 1,280 × 960

1 Lowest quality

2 Standard quality

3 Best quality

(8) (9) (10)(6)

(7)

(2) (3)

(7)

(11) (8) (12)

(1)

(2)

(6)

(4)

Play mode image (1 channel)Live mode image (Multi channels)

(1) (5)

(9)

Setting Description

OFF Audio will not be played.

ON-5SEC
ON-10SEC
ON-15SEC
ON-20SEC
ON-30SEC

Screen indicating the 
reading of audio data

Audio will be played.
Set the audio delay (5, 10, 15, 20, or 30 
seconds). 
In Play mode, the speed of fast-forward 
and frame advance may be affected by 
the network environment being used. In 
addition, if the audio-data reading screen 
appears frequently, the audio delay (5, 10, 
15, 20, or 30 seconds) should be made 
longer to match the network environment. 
If this screen continues to appear frequently 
even when the delay time is 30 seconds, it 
indicates that audio playback is not possible 
with the network environment being used.
* Audio delay
The delay time prevents sound dropouts 
and the loss of synchrony between video 
and sound.
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(6) Image mode
LIVE: Live mode
PLAY: Play mode

(7) Time
Live mode: Displays the current time
Play mode: Displays the recording time

(8) NORMAL RECORDING MODE
This item displays the current condition for normal 
recording.

STOP
RECORDING
TIMER STANDBY
TIMER RECORDING
AREA FULL (in normal recording area)

(9) ALARM RECORDING MODE
This item displays the current condition for alarm 
recording.

STOP
PRE ALARM RECORDING
ALARM RECORDING
AREA FULL (in alarm recording area)

(10)Connection user
In situations where a number of different users are 
connected, this item displays the connection condition for 
the various user levels.
Typical display: ID1: 3  ID2: 1  ID3: 0
The user ID for the current user is displayed in red.

(11)PLAYBACK AREA (in the play mode screen only)
This item displays the recording area for the current 
playback image

ALARM
PRE-ALRAM
NORMAL
ARCHIVE

(12)SPEED (in the play mode screen only)
This item displays the playback speed and direction.

If video with audio is to be downloaded to a PC, DVR 
Viewer must be installed before the necessary settings 
can be made. ( P. 2)

1 Live images will be displayed when 
connected with user level ID2 or ID3.

2 Set “SAVE TO PC” to “ON” and then 
click [SET]. 

The save setting items are displayed.

Screen display items

Display Playback direction Playback speed

PLAY Forward Normal

STILL Still Still

R.PLAY Reverse Normal

CUE Forward Fast-forward playback

REVIEW Reverse Fast-rewind playback

SLOW Forward Slow playback

R.SLOW Reverse Slow reverse playback

Settings for downloading live images 
to a PC
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3 Set “DURATION”.

The duration for images to be saved to the PC should be 
set in units of one minute.

4 Click [BROWSE].

A dialog box for selecting save location will be displayed, 
and a suitable location should be set.

It is also acceptable to input a location for saving 
directly into “DESTINATION FOLDER”.

5 Click [OK].

The setting menu will close and the screen will return to 
the condition for procedure 2 above.
The “DESTINATION FOLDER” location is displayed.

6 Click [START].

(1) The saving process begins. 
The elapsed save time and the current save image are 
displayed on screen. 
The elapsed save time will be incremented as the 
save progresses.

To cancel a save operation
Click [CANCEL].

(2) A pop-up window will be displayed when saving has 
been completed.
The final still image from the save process will be 
displayed.

7 Click [OK] in the pop-up window.

The setting menu will close and the screen returns to the 
condition for procedure 2 above.
Folders as shown below will be created within the folder 
set in procedure 4, and within these folders, images are 
stored with numbers assigned automatically.

(1) The folder “DVR00001” is created.
(2) Within this folder, folders are created in sequence 

starting with “IMG00001”. Images are stored in each 
folder.

Elapsed save time

DVR00001 000001.JPG
000002.JPG
000003.JPG

IMG00001
(1) (2)

DVR00002 000001.JPG
000002.JPG
000003.JPG

IMG00001
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3 SEARCH MODE

Images stored in the recording areas can be searched and played back in search mode. Furthermore, five different search 
methods are available for doing so.

1 In live mode (When playback is 
stopped), click the  button on the 
operation panel. 

The SEARCH screen is displayed.

2 Select and click the desired search 
mode from the SEARCH screen.

The screen for the selected search mode is displayed. 

3 Search for images using the search 
mode screen. 

See the following pages for more details regarding the 
different search procedures.

4 Check the returned images using the 
preview or thumbnail display and then 
click the screen.

Play mode will be activated and the playback of the full 
image will start. See “Performing operations in play mode” 
( P. 29) for more details regarding still image, fast-
forward, and other similar operations.

If the normal recording area is “*0%”, it will not be 
possible to select “ALARM SEARCH”, “ALARM 
THUMBNAIL SEARCH”, or “MOTION DETECTION 
SEARCH”.

Basic operation

Search menu

Search mode Recording area 
for searching Description

1 ALARM SEARCH Alarm recording area Lets you search and play back alarm images from the alarm event list.

2 ALARM THUMBNAIL 
SEARCH Alarm recording area Lets you search and play back alarm images using thumbnails.

3 TIME/DATE SEARCH Normal recording area and 
alarm recording area Lets you search and play back recorded images by date/time.

4 ARCHIVE AREA 
SEARCH Archive area Lets you search and play back images stored (or copied) to the archive area 

using an image list.

5
MOTION 
DETECTION 
SEARCH

Normal recording area and 
alarm recording area

Lets you search and play back recorded images of moving objects detected in 
accordance with motion sensor settings.
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In alarm search mode, images recorded in the alarm 
recording area are presented as a list of alarm numbers. 
Accordingly, alarm images from the recording list can be 
searched and played back.

(1) NO: Alarm number
(2) DATE/TIME: Recording date and time
(3) CH: Displays the channel on which alarm recording 

was performed
(4) PREVIEW: Displays a preview of alarm images
(5) [BACK]: Displays a list of the previous 8 images
(6) [NEXT]: Displays a list of the subsequent 8 images

1 Select “1. ALARM SEARCH” from the 
SEARCH menu. 

An alarm event list is displayed in the ALARM SEARCH 
screen with newer recordings displayed first. 

2 Select the alarm number to be played 
back from the alarm event list.

Clicking an alarm No. button displays a preview of the 
corresponding alarm image.
A maximum of 8 alarm events can be displayed on a 
single screen.
Click [BACK] or [NEXT] to display the alarm event list 
for the previous or subsequent 8 events accordingly.

3 Click the preview screen for the image 
to be played back. 

Full-screen playback will start from the point at which the 
alarm was triggered.

In alarm thumbnail search mode, all of the alarm images 
stored in the alarm recording area are displayed as 
thumbnails. Accordingly, you can search and play back 
alarm images using their thumbnails.

1 Select “2. ALARM THUMBNAIL 
SEARCH” from the SEARCH menu. 

The newest alarm images with attached alarm numbers 
are displayed in chronological order in the ALARM 
THUMBNAIL SEARCH screen.
A maximum of 9 alarm events can be displayed as 
thumbnails on a single screen.
Click [BACK] or [NEXT] to display the thumbnail screen 
for the previous or subsequent 9 events accordingly.

2 Click the thumbnail for the image to be 
played back. 

Full-screen playback will start from the point at which the 
alarm was triggered.

1. ALARM SEARCH

(1) (2) (4)

(5) (6)

(3)

2. ALARM THUMBNAIL SEARCH
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In date/time search mode, images from the normal 
recording area or the alarm recording area can be played 
back by specifying the corresponding date and time.

(1) RECORDING TOP: Displays the date and time of the 
oldest recording

(2) RECORDING END: Displays the date and time of the 
newest recording

(3) CHANNEL: Displays the channel (or camera number)
(4) SEARCH: Used to set the recording date and time of 

the image to be played back
(5) [PREVIEW]: Used to indicate preview display
(6) PREVIEW: Displays a preview of the image 

corresponding to the specified date and time

1 Select “3. TIME/DATE SEARCH” from 
the SEARCH menu. 

The TIME/DATE SEARCH screen is displayed.

2 Specify the channel or camera number 
from “CHANNEL” pull-down menu.

If only one channel is available, “--” will be displayed.

3 Specify the recording date and time for 
the image to be played back from 
“SEARCH” pull-down menu. 

Day/Month/Year/Hours/Minutes

4 Click [PREVIEW]. 
When the search has been completed, the image 
corresponding to the specified date and time will be played 
back.

If no image exists for the specified date and time, the 
image with the nearest recording date and time will be 
displayed.

5 Click the preview screen for the image 
to be played back. 

Full-screen playback will start.

In archive area search mode, you can play back recorded 
images stored (or copied) to the archive area.

(1) NO: Image number
(2) DATE/TIME: Recording date and time
(3) CH: Displays the channel on which recording was 

performed.
(4) CAPACITY TOTAL: Total capacity of the archive area
(5) CAPACITY USED: Amount of archive area capacity 

currently storing data
(6) PREVIEW: Displays a preview of the recorded image

1 Select “4. ARCHIVE AREA SEARCH” 
from the SEARCH menu. 

The search screen for the archive area is displayed. 
This screen contains a list of stored images displayed in 
sequence from the earliest item.

2 Select the image number to be played 
back from the stored image list.

A preview of the corresponding stored image is 
displayed.
A maximum of 8 stored images can be displayed on a 
single screen.
Click [BACK] or [NEXT] to display the image list for the 
previous or subsequent 8 images accordingly.

3 Click the preview screen for the image 
to be played back. 

Full-screen playback will start.

3. TIME/DATE SEARCH

(1)

(2)

(3)

(5)

(6)

(4)

4. ARCHIVE AREA SEARCH

(1) (2) (3) (6)(5)(4)
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By setting images recorded in the hard disk’s normal 
recording area or alarm recording area to the motion 
sensor, variations from these images as a result of the 
presence of an intruder or the like can be detected, and 
the corresponding images can be played back. 

(1) SEARCH FROM
The recording area to be used for motion searching

(2) CHANNEL
The channel or camera number to be used for motion 
searching

(3) START/END
The date and time of the start and end of the memory area 
for motion searching

(4) [SET]
Detection condition settings

(5) Message box
This box displays the results of searching for motion-
detection images

(6) MOTION SENSOR SET
Screen for making motion sensor settings

(7) MOTION SENSOR LEVEL
Motion sensor sensitivity setting: OFF or 1 through 10
(Lower numbers correspond to higher levels of sensitivity.)

(8) [PREVIEW]
Displays a preview of the detection image

1 Select “5. MOTION DETECTION 
SEARCH” from the SEARCH menu.

The motion detection search screen is displayed. 

2 Specify the recording area to be used 
for motion searching from “SEARCH 
FROM” pull-down menu.

[Settings] (  indicates default setting.)

3 Specify the channel (or camera number) 
for searching from “CHANNEL” pull-
down menu.

If the number of channels is one, “-” will be displayed here.

4 Click [SET].
The date and time of the start and end of recording of 
motion detection images is displayed in “START” and 
“END” respectively.

Use “START” and “END” to make new date and time 
settings when the searching range is to be reduced. 
The results of searching will be displayed in a message 
box when [SET] is clicked.

5 Setting motion sensor detection 
conditions.

Motion sensor positions
The motion sensor setting screen shows an 8 x 10 
(height x width) grid of sensors, and when one of these 
sensors is clicked, the corresponding sensor setting 
mark will turn red. If the same location in the grid is 
clicked once again, the motion sensor will be 
deselected.
Motion sensor sensitivity
Lower numbers correspond to higher levels of 
sensitivity, and a setting should be made from the pull-
down menu.

6 Click [PREVIEW].
A search is carried out within the specified area for images 
in which motion was detected, and these images are then 
listed in recording sequence in the preview screen.

7 Click the preview screen for the image 
to be played back.

Full-screen playback will start.

5. MOTION DETECTION SEARCH

When searching “SEARCHING”

When motion-detection 
images exist “FOUND!”

When motion-detection 
images do not exist “IMAGES NOT FOUND!”

(1)

(2)

(3)

(5)

(4)

(7) (8)

(6) Setting Description

ALARM Searching will only be performed for images 
in the alarm recording area.

NORMAL Searching will only be performed for images 
in the normal recording area.

ALARM AND 
NORMAL

Searching will be performed for images in the 
alarm recording area and normal recording 
area.
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5 SAVING RECORDED IMAGES

You can use the procedures described below to copy 
recorded images to the hard disk’s archive area or to 
download images to a PC or the like. 
These functions should be used to backup important 
images from the normal recording area and the alarm 
recording area.

Copied data is stored one image at a time. Moving 
images can be copied by setting the number of images 
required from the first copied image.
In a single copy operation, a maximum of 10,000 
images can be copied to the archive area and a 
maximum of 1,000 images can be downloaded to a PC.

In certain cases where network-busy is detected as a 
result of hardware conditions, the network may be 
forcibly disconnected in order to protect DVR recording 
operations. Furthermore, the network will be forcibly 
disconnected in response to a command to send a 
large amount of data in a single operation (in particular, 
when 100 images or more are to be saved), and in such 
a case, a limit should be applied to the number of 
images based on the hardware configuration in 
question.
When the archive area becomes full of images, these 
images are to be downloaded to a CompactFlash card 
or the like, and [AREA FULL RESET] from the 
recording area settings on the MAIN MENU should be 
clicked. ( P. 13)
Saving is only possible during full-screen display and 
not when multi-screen display is used.

(1) Recording date/time: The recording date and time for 
the image currently being played back

(2) PLAYBACK AREA:
The area in which the image currently being played 
back is recorded

NORMAL
ALARM

(3) HOW MANY: Setting for the number of images to be 
stored

(4) Message box: Displays the state of progress for 
copying

(5) [START]: Starts copying

1 Play an image from the normal 
recording area or the alarm recording 
area.

2 Click the  button at the start of the 
image to be copied.

Playback of the image is paused.

3 Click the  button on the operation 
panel.

The COPY screen is displayed.

4 Input the number of images into “HOW 
MANY”.

Specifically, indicate the number of images after the start 
image to be copied in succession.
Setting range: 1 to 10,000
A warning message will be displayed if an invalid number 
is entered here.

5 Click [START]. 

Copying to the archive area will begin and the message 
box will display the current state of progress.
[Settings]

The COPY screen cannot be displayed when playing 
video from the archive area.

6 When copying has been completed, 
click the  button to display live 
video or the  button to display 
playback video.

Copying to the archive area

(4)

(1)

(2)

(3)

(5)

Setting Description

Copying “COPYING TO ARCHIVE AREA!”

Copying completed “COPY FINISHED!”
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Use the following procedure to download recorded images 
to a PC.

(1) Recording date/time: The recording date and time for 
the image currently being played back

(2) PLAYBACK AREA:
The area in which the image currently being played 
back is recorded

NORMAL
ALARM
ARCHIVE

(3) HOW MANY: Setting for the number of images to be stored
(4) Message box: Displays the state of progress for 

downloading
(5) AUDIO: Setting for audio
(6) [START]: Starts downloading

1 Play a recorded image.

2 Click the  button when the image to 
be downloaded is being played back. 

Playback of the image is paused.

All images from the normal recording area, alarm recording 
area, and archive area can be selected for downloading.

3 Click the  button on the operation 
panel.

The DOWNLOAD screen is displayed. 

4 Input the number of images into “HOW 
MANY”.

Specifically, indicate the number of images after the start 
image to be downloaded in succession.
Setting range: 1 to 1000
A warning message will be displayed if an invalid number 
is entered here.

Due to Internet Explorer limitations, the number of 
images to download must be set so that all downloads 
will be completed within approximately 5 minutes.

5 Select the “AUDIO”.
[Settings] (  indicates default setting.) 

Audio cannot be selected when downloading from the 
archive area.

6 Click [START]. 
Downloading will start and the message box will display 
“PLEASE WAIT!”.
When all of the specified images have been downloaded, the 
image viewer screen will be called up and you will be prompted 
to confirm that the corresponding data is to be saved.

7 Click [OK].

8 Specify a location for storing the data.

If storing only video;
Select [Save As…] from the Internet Explorer [File] menu, 
specify the storage location and file name in the [Web 
Page] dialog box, and then click the [Save] button.

If storing video and audio;
Click the [SAVE WITH AUDIO] button, specify the storage 
location and file name in the [SAVE WITH AUDIO] dialog 
box, and click the [SAVE] button. A confirmation box will 
be displayed when saving has been completed, and [OK] 
should be clicked here.

Internet Explorer 5.0 or later must be used: Saving of 
images will not be possible with earlier versions or other 
browsers.
A time restriction of approximately 2 minutes is applied 
to the downloading of audio data, and for this reason, 
downloading may not be possible when there are a 
large number of images.

Downloading to a PC

(3)

(4)

(1)

(2)

(5) (6)

Setting Description

   ON Image audio will be copied.

OFF Audio will not be copied.
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* Image viewer screen
This screen allows you to check images that have been downloaded.

(1) [TOP]
Displays the first image.

(2) [PREV.]
Moves to the previous image.

(3) [R.PLAY]
Starts reverse playback. When the first image is reached, 
reverse playback will automatically continue from the last 
image.

(4) [STOP]
Stops playback.

(5) [PLAY]
Starts playback. When the last image is reached, playback 
will automatically continue from the first image.

(6) [NEXT]
Moves to the next image.

(7) [END]
Displays the last image.

(8) IMAGE SIZE
Sets the size of the display image.

(9) PLAY SPEED
Sets the playback speed.

* The playback speed values will depend on the computing 
power of the PC being used.

(10) IMAGE NUMBER
Displays the number of the image currently being played 
back.

(11)[PLAY AUDIO]
Plays back the audio (you can also play back both audio 
and image on the screen).

(12)CHANNEL
Displays the download channel (or camera number).

(13)TIME
Displays the recording date and time for the image 
currently being played back.

(14)DOWNLOAD COUNT
Displays the download progress in the form of “image 
currently being downloaded/total number of images to be 
downloaded”. (If recording do not exist for all entered 
images, the overall number will be restricted to the 
recorded number.)

(15)[SAVE WITH AUDIO]
Saves both the image and audio.

Windows Media Player must be installed in order to 
playback audio using Image Viewer.
Audio and video may not synchronize in Image Viewer. 
If it is important that audio and video be in perfect 
synchrony, DVR Viewer should be used for playback.

Thumbnail
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1 400 × 300 4 1,024 × 768
2 640 × 480 5 1,280 × 960
3 800 × 600

1 1 sec 4 0.125 sec
2 0.5 sec 5 0.05 sec
3 0.25 sec
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1 DVR VIEWER 

The DVR Viewer is a program designed specifically for 
DVRs. It can be used to play back image and sound data 
that has been copied onto media such as computer hard 
disk drives, CompactFlash cards. 
The DVR Viewer can be downloaded from the Sanyo 
website at the URL given below.
Sanyo website URL: 
http://www.sanyosecurity.com

When playing back sound data, you will need Version 
1.5 or later.

The following operating environment is required in order to 
use the DVR Viewer.

Applicable operating system: Windows 98, 98SE, Me, 
NT4.0, 2000, XP
Applicable computer: PC/AT compatible computer 
running one of the above operating systems

If an older version of DVR Viewer or ActiveX is installed, 
remove them from [Control Panel] → [Add or Remove 
Programs] in advance.

Install the DVR Viewer by the following procedure.

1 Starting the installation wizard
Double-click the icon for the downloaded “Setup.exe” file 
to start the installation wizard. 

2 Selecting the language settings
Select the display language for the software (English) in 
the [Choose Setup Language] window and then click [OK]. 

3 Starting the installation

Click [Next>] in the [Welcome to the InstallShield Wizard 
for DVR Viewer] window to start the installation process.

4 Choosing the destination location

Check that the destination folder shown in the [Choose 
Destination Location] window is correct, and then click 
[Next>]. 
If you would like to change the folder, click [Browse...] and 
specify the desired folder. 

5 Starting copying of files

Check that all the settings shown are correct, and then 
click [Next>]. Copying of files will then start. If you would 
like to change any of the settings, click [<Back]. 

6 Completion of installation

When the installation is complete, the [Maintenance 
Complete] window appears. Click [Finish].

Operating environment

Installing the DVR Viewer

e00_l8hbe_xe_nw_7.book  Page 40  Monday, April 26, 2004  10:40 AM



DVR VIEWER1

English 41

From the Start menu, select [Programs] → [DVR Viewer] 
→ [DVR Viewer] in the sequence to start the program.

When DVR Viewer starts up, the following default window 
appears.

If you create a shortcut icon for DVR Viewer on the 
desktop, you can open DVR Viewer quickly by double-
clicking the shortcut icon.
To create a shortcut icon, right-click [Programs] → 
[DVR Viewer] → [DVR Viewer] in the Start menu, drag 
the name to a spare place on the desktop, and select 
[Copy Here].

Click the close button in the top-right corner of the program 
window, or select [Exit (X)] from the [File (F)] menu to 
close DVR Viewer.

The basic menus for DVR Viewer are located on the menu 
bar and tool bar in the upper-left of the window. Click a 
command to open the corresponding menu.

This is the basic menu for DVR Viewer. Click a command 
to view the details for that command.

(1) File (F)
Open (O): Displays the Open file dialog box.
Print (P): Prints the specified file.
Title Input (T): Displays the dialog box for entering titles for 
printed images.
Exit (X): Closes DVR Viewer.

(2) View (V)
Toolbar (T): Displays and hides the toolbar.
Status bar (S): Displays and hides the status bar at the 
bottom of the window.
Separate (P): Moves the boundary line at the bottom of the 
window up and down.
Date Display Format (D): Sets the date display format.

(3) Help (H)
Displays the version information for the DVR Viewer that is 
currently open.

Opening and closing DVR Viewer

Opening DVR Viewer

Closing DVR Viewer

Menu structure

Menu bar

(3)(2)(1)
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This contains commands that are most often used.

(1) Corresponds to the [Open (O)] command in the [File 
(F)] menu.

(2) Corresponds to the [Print (P)] command in the [File 
(F)] menu.

(3) Corresponds to the [Help (H)] command.

When DVR Viewer is opened, you can open files to be 
played back by the following procedure.

1 Click [Open (O)] in the [File (F)] menu.

Alternatively, click the  icon on the toolbar.

2 Specify the drive and folder containing 
the file to be opened.

In the [Open] dialog box, use the radio buttons to select 
one of the following two options depending on the type of 
media that contains the image data.

(1) Open a folder with JPEG images
Select this option if you would like to open JPEG images 
that have been copied from a DVR to a CompactFlash 
card or that have been downloaded to the computer over a 
network. 
Click [Browse...] to display the folder tree. Specify the 
folder to be viewed and then click [OK]. 
If you would like thumbnail images to appear, check [Show 
Thumbnails]. 

To play back sound, be sure to specify a folder that 
contains “WAV” files.
This digital video recorder does not support the “Open 
images on CD-R” option in the dialog box.

To open images on a CD-R, select the CD-R drive name in 
question using the “Open a folder with JPEG images” in 
the dialog box.

Toolbar

Opening files

(3)(2)(1)
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When image files are opened, the images that have been loaded appear. The display window consists of a main window and 
a thumbnail window, and you can use various operations in these windows such as a slideshow. 

(1) Main window
When you double-click a thumbnail image, the image 
appears larger in the main window.
When files are opened, the image whose file name has the 
smallest number will be displayed.

(2) Thumbnail window
All images that are stored in the specified folder appear as 
thumbnail images (compressed images) in ascending 
order of filename number. Thumbnail images that will not 
fit in the window can be viewed using the scroll bar.

(3) Control panel ( P. 44)

Viewing images

(1)

(2)

(3)

000001.jpg 000002.jpg 000003.jpg 000004.jpg 000005.jpg

01/01 /2004  10:15:10

01/ 01/ 2004 10:15:10Time 
stamp
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(3) Control panel
This is used for playback operations in the main window and to adjust the images.

(1) [TOP]
Moves to the start of a slideshow.

(2) [PREV]
Moves to the previous image in a slideshow regardless of 
the setting for “(8) SKIP”.

(3) [RPLAY]
Reverses back of the slideshow by skipping through the 
number of images specified by “(8) SKIP”.

(4) [STOP]
Stops the slideshow.

(5) [PLAY]
Starts continuous playback of the slideshow by skipping 
through the number of images specified by “(8) SKIP”.

(6) [NEXT]
Moves to the next image in a slideshow regardless of the 
setting for “(8) SKIP”.

(7) [END]
Moves to the end of a slideshow.

(8) SKIP (Default setting: 1)
This sets the number of images that are skipped when 
playing and reverse playing slideshows. When using the 
default setting (= 1), all images are played back one at a 
time.
Setting values: 1, 2, 3, 4, 5, 10, 20, 30, 40, 50, 100, 200

(9) IMAGE SIZE (Default setting: 1)
The display size for images in the main window can be set 
to one of five sizes.
To display large image, select higher values.

(10)PLAY SPEED (Default setting: 3)
The playback speed for slideshows can be set to one of 
five speeds.

The actual playback speed may vary depending on the 
computer’s performance.

(11) IMAGE NUMBER
Shows “Current image number/Total number of images”. 

(12)TIME
Shows the time stamp for the displayed image.

The day, month and year order is defined by the 
settings at the computer.

(13)TIME POSITION (Default setting: LOWER RIGHT) 
This specifies the display position for the time stamp. 
Available settings: LOWER RIGHT, UPPER RIGHT, 
UPPER LEFT, LOWER LEFT

(14)Playback Audio
If this box is checked for a video file with audio, audio 
playback will be possible.

(7)(6)(5)(4)(3)(2)(1) (8)

(9)

(10)

(11) (12) (13)

01/01 /2004  10 :15 :10

(14)

1 400 × 300 4 1,024 × 768
2 640 × 480 5 1,280 × 960
3 800 × 600

1 1 sec 4 0.125 sec
2 0.5 sec 5 0.05 sec
3 0.25 sec
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Specified images can be printed as full screens together 
with date and time information.

1 To print the image in the main window

Select [Print (P)] from the [File (F)] menu, or click the  
icon on the toolbar. The Windows print dialog box appears. 
Make any settings that are required such as selecting the 
printer and the number of copies to be printed, and then 
click [OK]. The main window will then be printed with the 
time stamp embedded in the image.

2 To print thumbnail images

Click the thumbnail image to be printed so that it appears 
in blue, and then repeat procedure 1 above.

3 To print several images all at once

Hold down the [Ctrl] key on the keyboard, and then click on 
the images to be printed in the thumbnail window to select 
them. To select a contiguous range of images on the same 
line, hold down the [Ctrl] key and the [Shift] key 
simultaneously and then select the images. After selecting 
the images to be printed, carry out procedure 1 above. The 
selected images will then be printed one by one.

4 To display titles

To display titles for the images being printed, select [Title 
Input (T)] from the [File (F)] menu to display the Title Input 
dialog box. 

The title entered will appear underneath the printed 
image. Up to 10 entered titles can be saved and 
selected from a list.

Printing images

01/0 1/20 04  10 :15 :10

01/01/2004  1 0 :15 :10
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